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Related Manuals

To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for the devices that are used in the
system.

The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON)
and Delta Tau Data Systems, Inc (DT).

Manufacturer | Manual No. Model Manual nhame

OMRON 1610-E1 Model CK3E-11710 CK3E-series Programmable
Multi-Axis Controller Hardware
User’s Manual

OMRON 0036-E2 Model CK3M-CPU1[]1 | CK3M-series Programmable
Multi-Axis Controller
Hardware User’s Manual

OMRON W580-E1 Model Industrial PC Platform NY-series IPC
NY512-A6001XX21391 | Programmable Multi-Axis Controller
X Industrial Box PC Hardware User’s
Manual
OMRON Z362-E1 Model ZW-80000 Confocal Fiber Type Displacement
Model ZW-700001 Sensor User’s Manual
Model ZW-500001
DT 0014-E - Power PMAC User’s Manual
DT 0015-E - Power PMAC Software Reference
Manual

DT 0016-E - Power PMAC IDE Users Manual




2. Terms and Definitions

Term Explanation and Definition
Slave Slaves are devices connected to EtherCAT. There are various types of
slaves such as servo drivers handling position data and I/O terminals
handling the bit signals.
Object Represents information such as in-slave data and parameters.
PDO One type of EtherCAT communications in which Process Data Objects

communications
(Communications
using Process Data
Objects)

(PDOs) are used to exchange information cyclically and in real time.
This is also called “process data communications”.

PDO Mapping The association of objects used for PDO communications.

PDO Entry PDO entries are the pointers to individual objects used for PDO
mapping.

ESI file An ESI file contains information unique to the EtherCAT slaves in XML

(EtherCAT Slave format.

Information file)

You can load ESlI files into the Power PMAC IDE, to easily allocate
slave process data and make other settings.

ENI file
(EtherCAT Network
Information file)

An ENI file contains the network configuration information related to
EtherCAT slaves.

Power PMAC IDE

This computer software is used to configure the Controller, create user
programs, and monitor the programs.
PMAC is an acronym for Programmable Multi-Axis Controller.




3. Precautions

(1) Understand the specifications of devices that are used in the system. Allow some margin
for ratings and performance. Provide safety measures, such as for installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrences.

(2) To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in
the system.

(3) The user is encouraged to confirm the standards and regulations that the system must
conform to.

(4) 1t is prohibited to copy, reproduce, or distribute a part or the whole of this document
without the permission of OMRON Corporation.

(5) The information contained in this document is current as of April 2019.

It is subject to change without prior notice for improvement purposes.

The following notations are used in this document.

Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or may result in serious
injury or death. Additionally, there may be severe property

/A WARNING

damage.

f C t Indicates a potentially hazardous situation which, if not avoided,
aution may result in minor or moderate injury, or property damage.

IE' Precautions for Correct Use

Precautions on what to do and what not to do to ensure correct operation and performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operations easier.

Symbols

The filled circle symbol indicates operations that you must carry out.

The specific operation is shown in the circle and explained in text.

This example indicates a “general precaution” for something that you must
carry out.




Overview

This document describes the procedures used to connect the OMRON Confocal Fiber Type
Displacement Sensor Controller Equipped with EtherCAT model ZW-5000 (hereafter referred
to as the Slave) using OMRON Programmable Multi-Axis Controller model CK3E-LI IO
/CK3M-CPU1O1/NY5100-AOO0O (hereafter referred to as the Controller) and EtherCAT, as
well as for checking the connection.

Refer to Section 6. EtherCAT Connection Procedure to learn about the setting methods and
key points to perform PDO communications via EtherCAT.



5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices
The applicable devices are as follows:

Manufacturer Name Model
OMRON Programmable Multi-Axis Controller Model CK3E-OJO0O0O
OMRON Programmable Multi-Axis Controller Model CK3M-CPU1[]1
OMRON Programmable Multi-Axis Controller Model NY510O0-AOO0O

Industrial Box PC
OMRON Confocal Fiber Type Displacement Sensor
_ ) Model ZW-5000
Controller Equipped with EtherCAT

IE' Precautions for Correct Use

In this document, the devices with models and versions listed in Section 5.2 are used as
examples of applicable devices to describe the procedures to connect the devices and check
their connections.

You cannot use devices with versions lower than the versions listed in Section 5.2.

To use the devices mentioned above with models not listed in Section 5.2 or versions higher
than those listed in Section 5.2, check the differences in the specifications by referring to the
manuals before operating the devices.

@ Additional Information
This document describes the procedures to establish the network connections. It does not
provide information on operations, installations, wiring methods, device functionalities, or
device operations, which are not related to the connection procedures. For more information,
refer to the manuals or contact your OMRON representative.



I 5.2. Device Configuration

The hardware components to reproduce the connection procedures in this document are as

follows:

Power PMAC IDE

Model NY510-A00O0

EtherCAT

communications

Model ZW-5000

Manufacturer Name Model Version

OMRON Programmable Multi-Axis Model NY510-A0000 Ver.2.5 or
Controller later
Confocal Fiber Type

OMRON Displacement Sensor Model ZW-5000 Ver. 1.1
Controller Equipped with
EtherCAT

OMRON Ethernet cable (with industrial Model
Ethernet connector) XS5W-T421-00MO-K

DT Power PMAC IDE - Ver.4.2.1.19

IE' Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

IE' Precautions for Correct Use

Do not share the connection line of EtherCAT communications with other Ethernet networks.

Do not use devices for Ethernet such as a switching hub.
Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or
higher, and use the shielded connector of Category 5 or higher.

Connect the cable shield to the connector hood at both ends of the cable.

@ Additional Information
This document describes model NY51[]-ACIC as an example. The same procedures can

apply to model CK3E-O O/ CK3M-CPU1[1.

©



6. EtherCAT Connection Procedure

This section describes the procedure for connecting the Controller with the Slave via EtherCAT.
The description assumes that the Controller is set to factory default.

I 6.1. Workflow

Take the following steps to operate the PDO communications via EtherCAT after connecting
the Controller with the Slave via EtherCAT.

6.2 Preparation for the Controller Setup Prepare the Controller settings.
v

6.2.1 Creation of a New Project
v

6.2.2 Initial Settings of the Controller
v

6.3 Installation of ESI Files Install the ESI file for the Slave into
PowerPMAC IDE.

v
6.4 EtherCAT Communications Setup Set up EtherCAT communications.
v
6.4.1 Communications Setup for the EtherCAT Master
v
6.4.2 Distributed Clock Setup
v
6.4.3 PDO Map Settings
v

6.4.4 Creation of an EtherCAT Network Configuration
File

v
6.5 Controller Settings Set up the Controller.
v
6.5.1 EtherCAT Communications Check
v
6.5.2 Writing the User Program
v
6.5.3 Project Data Transfer

10



I 6.2. Preparation for the Controller Setup

Prepare the Controller settings.

6.2.1. Creation of a New Project

1

Turn on the power to the
Controller.

2

Start Power PMAC IDE.

* |f the dialog for confirming
access rights appears upon
start-up, select starting of
Power PMAC IDE.

&

PowerPMAC
IDE

The Communication screen
appears. Specify the IP
address of the destination

Controller and click Connect.

* The IP address of the
Controller is set to
“192.168.0.200" by default.
* |If necessary, change the
Windows IP address to
“192.168.0.X".

@z
#=2

Al |

IP Address

Part

Protocol

Uzer

Pazzword
SelectDevice AtStartup

IP Address

et

IP Address

192.168.0.200
22

root
S90S

True

l

Cionnect ]

’ Lazt Sezzion IP ] [

Mo Device l

For detailed setup options go to Tools menu -> Options
-> PowerPMAC

11



4 Power PMAC IDE starts, and is

online to the Controller.

@ ramizois -
L R e R
B-ro-aBP XFQ 7T » -

0 b 2 ity | El et @i e [ Bl | o e et ey S

ProwrPRAC Cordiquration Warkdiow

@ PowerPMACIDE [ e b e |

B i

[

yr

5 From the File menu, select

New then Project.

@ Powervaces2110 [

File | Edit View Debug Tools DeltaTau EtherCAT  Window  Help
New '3 Project... Crl+Shift+N
Open Y File Cirl+N Je
Close -
Position
Close Solution
Position
Upload Project From PowerPMAC
W Save Selected Items Ctrl+S
Save Output As...
¥ Save All Ctrl+Shift+S
Export 3
Import 3
B Page Setup...
= Print... Ctrl+P
Recent Files 3
Recent Projects and Solutions 3
B Exit Alt+F4
G Enter aproject name, and
select OK. e
* Recent o Detu e
il _Q e S [rypes PowerMaC
PrwerPMAL — | bsie PormerPMAL prepest '
PruwerhaC Solution PewtrPMAL with (HRArCAT (Acorti] PowePMAC
Pouserftick LY Powe BT
Dame PowerFMACS
Location: \ige. - [Cowsen |
Sahaion name BrwerBhACS v Create directorf for solution
O o || conen
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6.2.2. Initial Settings of the Controller
Configure the initial settings for the Controller.

IE' Precautions for Correct Use

Configuring the initial settings clears all data in the Controller memory. Back up necessary

data in advance.

In the Terminal tab page, type the
$$$*** command to reset the
Controller to factory default.

@ PowePMACS - PowerpMac1E42119 (INNNNNNN

File Edit View Project Build Debug Teols DeltaTau E
(B~ -2 [ 9 - @ -||pebu
& StartPage ¥ Communication Setup | 5=] Terminal 4 Position

Watch Window

G Query

Sys.ServoCount 2764277 -
Sys.ServoPeriod 1

ECAT[0].Enable o

Motor[1].5ervoOut o]

Motor[1].Pos5f 1

Terminal

2 Select System — CPU — System
in the Solution Explorer.

Solution Explorer I x
W o-F|F -

Search Solution Explorer (Ctri+:) P~
1 PowerPMACS -
4 [ System

4 | CPU

3 Hardware
1 EtherCAT
3 Motors
3 Coordinate Systems
b [ Encoder
b [ C Language
b 3 Configuration
P [ Documentation
b [J Log -

Solution Explorer

3 Select Global Clock.

CPU Settings

Global Clock

Advanced View |




4 Specify Servo Frequency.

Global Clock Settings

Select the Servo Frequency

setting from 4 KHz, 2 KHz, or Phase Frequency 1 iz
1 KHZ Servo Frequency I [1_[.00 v] I kHz

5 Click the Accept button.

MNew clock  PowerPMAC
Items )

settings Value
Servo Period (msec) 1.000 1.000 -

EtherCAT option detected and no Master Gate -
detected, using internal clock by setting

. ays. CPUTimerIntr = 1. For EtherCAT the
ServoPeriod must be multiple of 62.5 usec. On
Accepting the clock issue save and type $55 in =

= Commeonly Used Structure Elements I[ Accept |

6 If you have changed the servo
frequency setting, type the SAVE | Terminal

AVITIY 1O T IO L OYTIEITIY 11PERS U 1193511

command in the Terminal tab
page of Power PMAC IDE Saving To Flash: Mounting the flash

Sawving To Flash: Finished SAVING to flash

When complete, the “Save Save Completed

Complete” message appears in

the Terminal tab page.

7 Click Delta Tau —
Communication Setup on the
toolbar to display the Device
Properties dialog box.

@ romermiacs_ poveriac 42110 ([T
File Edit View Project Build Debug Tools Delta Tau EtherCAT

|4,s1 P | -| Debug - Am

Watch Window

Command /Qui

Sys.ServoCount]

ECAT[D].EnabIj B4 |
4 Device -
ECATIO]-Eﬂabli- IF Address 192.168.0.200

Part 2 E

ECAT[0].Enable] Protocol S5H
- User root -
Sys.ServoPeriog| o
Set [P Address

Sys.ServoDeltaTl|
Sys.FltrservoTif||




8 In the Device Properties dialog .
box, select No Device for IP @ Device Properties e
Address, then click the Apply Text | Aoy
button.

4 Device - -
This operation sets the Controller T Address |E
to the offline state. Protoco) SSH b
_Ser ) rlm-t ------ -
IP Address
Set IP Address
! e = IJ
o] Restart the Controller.
The servo frequency that has
been set is reflected.
Wait until the startup process of
10 @ Device Proparties ﬁ

the Controller is complete. Then
click Delta Tau —
Communication Setup on the
toolbar to display the Device
Properties dialog box.

In the Device Properties dialog
box, return the IP Address to the
previous setting, then click the
Apply button.

This operation sets the Controller
to the online state.

Test Apply

IP Addreszz
Part
Protocal
|Jzer

IP Address
Set IP Address

192.163.0.200

55H

l.m

—

15



I 6.3. Installation of ESI Files

Install the ESI file for the Slave into Power PMAC IDE.

IE' Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

1 From the EtherCAT menu of Power
PMAC IDE, select ESI Manager.

@ PowerPMACS - PowerPMAC IDE 4.2.1.19

File Edit View Project Build Debug Tools Delta T3
|8-o-aRd|XFal?- -
i @ Start Page 4 Communication Setup | [5=] Terminal € Po

EtherCAT | Window Help
bug [ ESI Manager
o

P T ST [ 0 Ribbon | & T

Command/Query Response Position

Sys.ServoCount 577552

ECAT[0].Enable=1

FeRTTAT Fanbla A 1

2 Confirm that Omron ZW-7.xml is
registered in the ESI file list of ESI
Manager.

If it is not yet registered, click Add
FileandregisterOmron 2ZW-7.xml.

= ESI Manager M = | G ||

ESI Files I

Select an ESI file which should be deleted or exported or add new ESI files.

& Delta Tau Data Systems, Inc.
Omren Corperation

Omron 3G3AX-MX2-ECT.xml

Omron 2GIAY-RY-ECT xml

Add File I Add Folder Delete

T O Eol T

Number of devices: 360

E Close
r __
= Add ESI File [
@Ov|_ N ] = [ || Search Removable Dk ol
Organize v Newfolder o @
¢ Favorites Name Date modified Type
B Desktop 2| Omron ZW-Txml 5/24/201810:36 AM XML Doc
I8 Downloads
] Recent Places
) Libraries
3 Documents
&) Music
=] Pictures
B8 videos
18 Computer = - .
File name: Omron ZW-7.xml ~  |Supported Files (*xml".zip) -

3 Click Close to close the ESI

Manager page.

I 6.4. EtherCAT Communications Setup

Set up EtherCAT communications.

IE' Precautions for Correct Use
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Before taking the following steps, make sure that the devices are connected via an Ethernet
cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet




cable.

6.4.1. Communications Setup for the EtherCAT Master

1 Connect the Controller with

slave devices using an Ethernet

cable.

* Refer to the manuals for slave
devices to configure them.

2 Display Start Page of
EC-Engineer, and select
EtherCAT Master Unit (Class
A) from Add Master Unit.

Solution Explorer
W o -

rror

Search Solution Explorer (Ctrl+:)

0.00 rev
1 PowerPMACS
0.00 rev
4 [ System
0.00 rev b [3 CPU
[ Hardware
0.00 rev

Scope to This

1 Motors
[ Coordinate Systems
3 Encoder
B C Language

1
i Configuration

kA Dnenmantatinn

New Solution Explorer View

Properties Alt+Enter

Add EtherCAT Master (Acontis)

3 Class-A Master is added to the
Project Explorer.

Solution Explorer - I x
W o-d| f-
Search Selution Explorer {Ctrl+:) P~

—1 PowerPMACS
4 [ System
b 3 CPU
1 Hardware
4 |7 EtherCAT

| ¢ Mastero (Deactivated) |
[0 Motors

[ Coordinate Systems
p @ Encoder
[J C Language
[ Configuration
3 Documentation
[ Log
[ PMAC Script Language

v v v w7

Solution Explorer

17



4 In the Master page, specify a
communication period for Cycle
Time [us].

* You must specify the
communication period in
accordance with the servo
frequency of the Controller.
1000 us is set in this document.

Device Editor
Master |Topology View

General

Unit Name EtherCATSuite Master

[1000 |

I Cycle Time [us]

esaro eacevares) < [

Source MAC address

Slaves connected to local system
Network Adapter O—HilL T

Slaves connected to remote system
1P Address

102 (168 . 0 200
Port 6000
Master-Instance 0

Networks: 1 | Slaves: 0 |

7481 5 (In

tel(R) 1210

Gigabit Metwork Conne

| state: @ @ | Mode: cONFIG

Correspondence between the servo frequencies of the

Controller and communication periods is as follows:

4 kHz : 250 us
2 kHz : 500 us
1 kHz : 1000 us

Select System — EtherCAT in
the Solution Explorer and
right-click on Master0
(Deactivated), then select Scan
EtherCAT Network.

Following Error
0.00 rev
0.00 rev
0.00 rev

0.00 rev

Configuration Mode

Diagnosis Mode

I Scan EtherCAT Network I

Append Slave

Paste Slave

Import Slaves from ENI
Export ENI File

Load Mapping to PowerPMAC
Load Mapping to PowerPMAC From ENI
Activate EtherCAT

Edit Topology

EoE Endpoint Configuration
Open

Scope to This

New Solution Explorer View

/& Properties

Ctrl+V

Solution Explorer
@ o-a|rp -
Search Solution Explorer (Ctri+:)

1 PowerPMACS
4 [ System
b £3 CPU
4 Hardware
4[5 EtherCAT
Master( (Deactivated)
Ors
dinate Systems
ader
Lage
ration

entation

cript Language

=8 Class View

ctivated) File Propertie

Motors =
Master0 |
Ci¥lsers¥

jense

Alt+Enter

18



6 Make sure that the slave is
displayed in the Solution
Explorer. @ o-a|p -

Search Solution Explorer (Ctrl+:)

Solution Explorer

1 PowerPMACS
4 |7 System
P [dCPU
[ Hardware
4 | EtherCAT
4 & Master0 (Deactivated)
|__ @ Slave_1001 [ZW-5000] (1001)
[ Motors
[ Coordinate Systems
[ Encoder
[ C Language
[ Configuration
3 Documentation
1 Log
[ PMAC Script Language

Solution Explorer EelRE-RUEY

6.4.2. Distributed Clock Setup



1 Setting Distributed Clocks (DC)
for Master

In the MasterO (Deactivated)
tab page, select Distributed
Clocks tab.

Solution Explorer > B ox
@ o-a|Fp =
Search Solution Explorer (Ctrl+:) R~

1 PowerPMACS
4 [z System
P 3 CPU
3 Hardware

4 & Master0 (Deactivated)

1 Motors
1 Ceordinate Systems
B [ Encoder
[ C Language
[ Configuration
3 Documentation
3 Log
3 PMAC Script Language

Selution Explorer

v v v v v

Master0 (Deactivated) = X
Device Editor

| Master | Topology View | Process Data image | variables | Advanced Options| Slave to s\t. e | Distributed Clocks jsks + Sync Units |

Reference Clock

Name Slave_1001 [ZW-5000] (1001)

Clock Adjustment
© Master Shift (EtherCAT Master Time controlled by Reference Clock)
*) Bus Shift (Reference Clock controlled by EtherCAT Master Time)

) External Mode (Reference Clock controlled by External Sync Device)

Options
[C] Sync window Monitoring

[C] Show 64Bit System Time

Slaves with active DC

Slave_1001 [ZW-5000] (1001)

Networks: 1 | Slaves: 1 State: @ & | Mode: CONFIG

2 Select Master Shift (EtherCAT
Master Time controlled by
Reference Clock).

Master0 (Deactivated) + X

Device Editor

[ Master | Topology View | Process Data image | variables | Advanced Options| Slave to S\ave‘ Distributed Clocks ‘TaSks + Sync Units |

Reference Clock

Name Slave_1001 [ZW-5000] (1001)

® Master Shift (EtherCAT Master Time controlled by Reference Clock)

) External Mode (Reference Clock controlled by External Sync Device)

Options
[C] Sync Window Monitoring
[C] Show 64Bit System Time

Slaves with active DC

Slave_1001 [ZW-5000] (1001)

Networks: 1 | Slaves: 1 State: @ & | Mode: CONFIG

20




3 Setting Distributed Clock (DC)
for the Slave

In the Solution Explorer, select
the target slave and display the
Distributed Clock tab page.

Solution Explorer
@ o-a|p -

Search Solution Explorer (Ctrl+:) P~

1 PowerPMACS
4 [ System
p [ CPU
[ Hardware
4 [ EtherCAT

. )
i @ Slave_1001 [ZW-5000] (1001) II

[ Feers
1 Coordinate Systems
P[4 Encoder
3 C Language
[ Configuration
[ Documentation
[ Leg
3 PMAC Script Language

Solution Explorer

v v v v v

Sve_1001 tzv-soon) oo+ I

Device Editor —
| General ” PDO Mapping H Variables ” Advanced Optioni Distributed Clock ‘Init Commands H CoE Object-Dictionary H Sync Umts‘

Distributed Clock

-

Operation Mode DC Sync -
Sync Unit Cydle (us) 1000
Overwrite Mode B
Sync Units
Sync Unit 0
Cydle Time
Sync Unit Cycle %1 1000 us
User defined 1000

Shift Time (us)

Syne Unit 1
Cycle Time
Sync Unit Cycle 1 Ous
Sync 0 Cycle 1 Ous

User defined

Shift Time (us)

-

Networks: 1 | Slaves: 1 | State. Mode: CONFIG

4 Select the Overwrite Mode
check box and specify Shift
Time.

S0 tzwsone) oo [

Device Editor
| General " PDO Mapping ” Variables H Advanced Dpt\on5| Distributed Clock ‘Init Commands H CoE Ob]ect-D\ct\onarv” Sync Umts‘

Distributed Clock
Operation Mode DC

%)

Overwrite Mode I

Sync Units
Sync Unit 0

Cycle Time
@ Sync Unit Cycle x1 ~ | 1000 us
—str ol -
Shift Time (us) 500
[£] Sync Unit 1

Cycle Time
Sync Unit Cycle 1 Ous
Sync 0 Cycle x 1 Ous

User defined

Shift Time (us)

-

Networks: 1 | Slaves: 1 | | state: | Mode: coNFIG

Correspondence between the servo frequencies of
the Controller and Shift Time values is as follows:

4 kHz : 125 us

2 kHz : 250 us

1 kHz : 500 us

21



6.4.3. PDO Map Settings

1 In the Solution Explorer, select
the target slave to display the
PDO Mapping tab page.

Solution Explorer
& o-dFL -

Search Solution Explorer (Ctrl+:) P

] PowerPMACS
4 [Z System
b [4 CPU
3 Hardware
4[5 EtherCAT

F
[n)- Slave_1001 [ZW-5000] (1001)
[
3 Coordinate Systems
[ Encoder
[J C Language
[ Configuraticn
(3 Documentation
3 Log
3 PMAC Script Language

Solution Explorer

TS

v v v v v

Slave_1001 [ZW-5000] (1001) + X

Device em—
[ Generi‘ PDO Mapping Ivamab\es [ advanced options | Distributed Clock | tnit Commands | CoE Object-Dictionary | Sync Units
Inputs Outputs
257th transmit PDO Mapping (excluded by 0 0x1B00 257th receive PDO Mapping [excluded by O0x 0x1700
Name Index Bit Length Name Index Bit Length
Sensor Head Statu | 0x3010:01 32 Sensor Head Conti | 0x3000:01 32
258th transmit PDO Mapping (excluded by 0 Ox1B01 258th receive PDO Mapping (excluded by Ox Ox1701
Name Index Bit Length Name Index Bit Length
Sensor Head Statu | 0x3011:01 32 Sensor Head Conti | 0x3001:01 32
260th transmit PDO Mapping 0x1B03 260th receive PDO Mapping 0x1703
Name Index Bit Length Name Index Bit Length
FLG Bit 0x3010:02 1 EXE Bit 0x3000:02 1
SYNCFLG Bit 0x3010:03 1 SYNC Bit 0x3000:03 1
READY Bit 0x3010:04 1 Sensor Head Conti 0x3000:04 1
Sensor Head Statu 0x3010:05 1 Sensor Head Conti 0x3000:05 1
RUN Bit 0x3010:08 1 - Sensor Head Conti 0x3000:06 1 -
Add Delete Edit up Down
Networks: 1 | Slaves: 1 State: @ @ | Mode: CONFIG

2 Check the Inputs field to make
sure that the check boxes are
selected as follows

* |f you want to use other data,
clear the currently displayed
check boxes and select other
desired check boxes.

Inputs

257th transmit PDO Mapping (excluded by Ox1BO03)  Ox1BOO

258th transmit PDOD Mapping (excluded by Ox1B04)  Ox1BO1
260th transmit POO Mapping 0x1B03
261th transmit PDO Mapping Ox1B04
263th transmit PDO Mapping 0x1B06
264th transmit FDO Mapping Ox1B07
511th transmit PO Mapping 0x1BFE
512th transmit PDO Mapping Ox1BFF

22



3 Check the Outputs field to make
sure that the check boxes are Outputs

selected as follows. 257th receive PDO Mapping (excluded by 0x1703)  Ox1700
258th receive PDO Mapping (excluded by 0x1704) Ox1701
* If you want to use other data, 260th receive PDO Mapping 0x1703
clear the currently displayed

check boxes and select other

261th receive POO Mapping Ox1704

263th receive PO Mapping Ox1706

desired check boxes.

23



6.4.4. Creation of an EtherCAT Network Configuration File

1 Select System — EtherCAT in
the Solution Explorer and
right-click on Master0
(Deactivated), then select
Load Mapping to
PowerPMAC.

Solution Explorer v~} x
G o-ap -
Search Solution Explorer (Ctrl+:) P~
] PowerPMACS
4 [y System
b B3 CPU
[3 Hardware
4 [ EtherCAT
Liaster (Deactivated)

Slave_1001 [ZW-5000] (1001)
Diagnosis Mode 'S

Configuration Mode

Scan EtherCAT Metwork inate Systems

jer
ge
Paste Slave Cerl+V ation

Append Slave

Import Slaves from ENI ntation

B EE AR ript Language
I Load Mapping to PowerPMAC I
Class View
Load Mapping to PowerPMAC From ENI
Activate EtherCAT ZwE
ivated) File Properties o
Edit Topology
EoF Endpoint Configuration
& Gz 58 Motors = 256
Scope to This Master0 (Deactivated)

B Mew Solution Explorer View ci¥users¥pmac4¥Documen|

Acontis

& Properties Alt+Enter

2 An eni.xml file is added under
the Configuration directory in
the Solution Explorer.

Solution Explarer > I x
A o-a|F-=
Search Solution Explorer (Ctrl+:) P~

1 PowerPMACS

b [3 System

b [J CLanguage

4 [z Configuration
[ ECATConfig.cfg
B enixml
[ pp_custom_save.cfg
[ pp_custom_save.tpl
=] pp_disable.txt
=] pp_inc_disable.txt
=] pp_inc_startup.bxt
[ pp_save.cfg
=] pp_startup.tet
[ systemsetup.cfg

b [ Documentation

b [dLog

b [3 PMAC Script Language

Solution Explorer

3 An ECATMap.pmh file is added
under the PMAC Script
Language/Global Includes
directory in the Solution
Explorer.

Solution Explorer * B ox
G o-a f -
Search Solution Explorer (Ctrl+:) P

1 PowerPMACS

b 3 System

b [ CLanguage

B [ Configuration

b [ Doecumentation

> [ Log

4 [ PMAC Script Language

4 [ Global Includes
[ global definitions.pmh
(M) ECATMap.pmh

[ Kinematic Routines
b [J Libraries
b [3 Motion Programs
b [ PLC Programs

Solution Explorer
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I 6.5. Controller Settings

6.5.1. EtherCAT Communications Check

Take the following steps to ensure that EtherCAT communications are available.

1 From the Terminal tab page, run
the ECAT[0].Enable=1 command
to start EtherCAT communications.

Terminal

)0 successful

ECAT[D].Enable=1|

2 In the Terminal tab page or Watch Watch Window H v 0 x
Window, make sure that the
ECAT[0].Enable value turns to 1.

Command/Query Response
Sys.ServoCount 12960793

* The OP mode is entered and ECAT[0].Enable
EtherCAT communications are

established.

3 After making sure that correct

Terminal

communications are available, run Nelcome to Pon C terminal

the ECAT[0].Enable=0 command mmunicatior
from the Terminal tab page to stop ECAT[0] Enable=1
EtherCAT communications.

ECAT[0].Enable=0|

4 In the Terminal tab page or Watch Vatch Window

Window, make sure that the

Command/Query Response
ECAT[0].Enable value turns to O.

Sys.5ervolCount 13312872

ECAT[0].Enable
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6.5.2. Writing the User Program

Create programs to be used to check operations.
A specific language is used for the operation check programs. Refer to Power PMAC User’s

Manual and Power PMAC Software Reference Manual for details.

1

In the Solution Explorer pane,
open Project name — PMAC
Script Language — PLC
Programs — plcl.plc.

plcl.plc & x

// Power PMAC Script PLC Program Template. ES
// The following Sample PLC PROGRAM is the st a
// Sample PLC PROGRAM

// open plc 1

ff = User Code Goes Here---
close
/

00% ~| 4 »

Solution Explorer
SRR
Search Solution Explorer (Ctr 0O -
] PowerPMACS
b [3 System
[3 C Language
[ Configuration
1 Documentation
3 Log
= PMAC Script Language
I [ Global Includes
[J Kinematic Routines
P 3 Libraries
P 3 Motion Programs
- Dl C p

Fi ogrgn
[ plci.ple

[

Solution Explorer

In the programming area of the
plcl.plc tab page, write a
program as shown on the right.

This sample program repeats
the process of sending the
command after one second,
turning OFF the transmission bit
after one second, sending the
command after one second,
then turning OFF the
transmission bit after one
second.

* In this example, PDO mapping
is assumed to be the default
setting. If you want to change
PDO mapping, rewrite the
“Slave_0....” description.

open plc 1
while(sys.ecatMasterReady==0){};
ECAT[O].Enable = 1;

P1000 = Sys.Time + 1;
while(P1000 > Sys.Time){};

Slave_0 3003 _0_Command = $00404000;
Slave_0 3004 1 CommandParameterl = 900;

Slave_0_3000_2_EXEBit = 1;
P1000 = Sys.Time + 1;
while(P1000 > Sys.Time){};
Slave_0_3000_2_EXEBit = 0;

P1000 = Sys.Time + 1;
while(P1000 > Sys.Time){};

Slave_0_ 3003 0 _Command = $00404000;
Slave_0 3004 1 CommandParameterl = 901;

Slave_0_3000_2 EXEBit = 1;

P1000 = Sys.Time + 1;
while(P1000 > Sys.Time){};

Slave_0_3000_2 EXEBIt = 0;

close

26



3 Setting the start of the user pp_disable.it = X

/1#°k //¥ill all the motors (This ¢

program &*A //Abort ALl Programs @ o-a|p -
disable plc @..31 //Disable all Script PLCs Search Solution Explorer (Ctrl+ 0O -
clear all buffers
| PowerPMACS
In the Solution Explorer pane, TP sy
P [ CLanguage
open Project name — 4 |z Configuration
[ ECATConfig.cfg
Configuration — =] enioxml

[ pp_custom_save.cfg
[ pp_custom_save.tpl
=] pp_inc_disable.t
=] pp_inc_startup.txt
[ pp_save.cfg
=] pp_startup.txt
[ systemsetup.cfg

b [d Documentation

b 3 Log

b 3 PMAC Script Language

100% - Solution Explorer

pp_disable.txt.

4 In the programming area of the
pp_disable.txt tab page, add the enable plc 1;
program shown on the right to
the last line.

The pp_disable.txt program is
automatically executed when
the Controller starts.

This example program runs the
PLC1 script.

6.5.3. Project Data Transfer
Transfer the created project data to the Controller.

/A WARNING

When the user program and “configuration and setting” data are transferred from
Power PMAC IDE, devices or the machine may perform unexpected operations.
Therefore, before you transfer project data, ensure the destination slave is
operating safely.

Transferring project data restarts the Controller and interrupts communications
with slaves. The time that communications are interrupted depends on the
EtherCAT network configuration.

Before you transfer project data, make sure that the slave settings will not
adversely affect the devices.
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1 In the Terminal tab page or

Watch Window, make sure that
the ECAT[0].Enable value is 0.

If the value is 1, run the
ECAT[0].Enable=0 command
from the Terminal tab page to
stop EtherCAT
communications.

Watch Window

Command/Query

Sys.ServoCount

ECAT[0].Enable 0

Response
13312872

Downloading a project

Right-click the project name in
the Solution Explorer pane on
the upper right of the IDE
screen, and select Build and
Download All Programs to
run the build and download.

* The transferred project is not
yet saved to the Controller at
this stage.

If you turn OFF the power to
the Controller, the transferred
project will be discarded.

Solution Explorer - 1 x

@ o-a|F =

Search Solution Explorer ({ 0 ~

Fe

Build
Rebuild

Clean

New Solution Explorer View

=

Build and Download All Programs I

Map PMAC Variables

Add Macro Project

Export Project with IP Protection...

Export Project Template...

Cut Cerl+X
Unload Project

Open Folder in File Explorer

Properties Alt+Enter

PowerPMACS

T System

1 C Language

1 Configuration

1 Documentation

T3 Log

1 PMAC Script Language

Make sure that there are no
errors in the Output Window.

* If the transfer fails, check
details of the error in the
Output Window.

If the error is a program error,
you must review the program.
If the error is related to
EtherCAT settings, return to
6.4 EtherCAT Communications

Setup and check whether there

are any incorrect settings.
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4 The program starts running
when it has been downloaded

Terminal

successfully.

EtherCAT communications are
in the OP state. Make sure that
the command is sent.

enable plc 1|

* If the command is not sent,
check that the ECAT[0].Enable
value is 1 in the Terminal tab
page or Watch Window.

If the value is O, run the
following command from the
Terminal tab page.

enable plc 1

5 After you have confirmed an
appropriate operation, save the
project to the Controller.

Terminal

Available dizk =pace
Required disk space = 147
Saving To Flagh: Syncing files to flash

Run the save command from
the Terminal tab page.

Saving Te Flash: Mounting the flagh
Saving Te Flash: Finished SAVING to flash

* The save command stores EEEETTTET

the downloaded project in the |3EWE4
Controller. This operation
saves the settings to be
executed automatically when
the power to the Controller is
turned on.
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7. Appendix Saving and Loading a Project

The following describes the procedures to save a Power PMAC IDE project on the computer, and to
reuse it.

I 7.1. Saving a Project

1 Creating a Configuration File L o sswiecnoon - I TR
= A o-a[p=

—J Search Solution Explorer (Ctrl+;) P~

] R88D-1SN

Create a Configuration File to save b O stem

b [ CLanguage
| | 4 B Configuation |
parameters you have changed. D EcATConfgstg e

4] eniml Scope to This
_custom_save.cfi 5 New Solution Explorer View
PP, ] p

[ pp_custom_save.tpl r

Properties Alt+Enter
=] pp_disabledt
Right-click Configuration in the Solution st N

D) pp_savecfg

Explorer pane, and select Generate Config 2 pp satupoe

[ systemsetup.cfg

Generate Config File

b [Z3 Documentation

File. > Cileg
b [ PMAC Seript Language
A Configuration File is added to

Configuration.

2 Enter a file name in the textbox, then click - - -
the OK button. @ pr_dificiy

Pleaze type a name for the Gonfig File.

[ 0] 4 ] l Cancel l

[ ———

3 Right-click on the Configuration File, and Oy pp_savecfq
from the menu, select Check To Download - ppterup

Config File to include it in files to be O & Open
b [d D Open With...
downloaded. b EdLe

4 [ PH

4 |5 Scope to This

<>  View Code

New Solution Explorer View

Exclude From Project

Solution Ex
O Copy Ctrl+C

| XX Delete Del

R88D-1SN Rename T

= | I Check To Download Cenfig File I

B FileEna & properties Alt+Enter
Enable Enerypmon ™O

B Misc
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3 Saving a Project

In the File menu, run Save All to save the
project on the computer.

Ra0-15N - Powerpaac 0 42119 (N

File § Edit View Project Build Debug Tools

Delts Tau  Ed

Mew

Open

Close
E  Close Project

Upload Project From PowerPMAC
I Save R8BD-1SM.cfg

Save RBBD-15N.cfg As...

W Savedll

Export

Impart

Page Setup..

Print...

Recent Projects and Solubions
Exit

Ctrl+5

Ctrls Shift=§

Ctrls P

Alt+Fd4

3

L

Debug
5} Position [0

Moter[1].Idata[11]=1176256512
Motor[1].Idata[12]=1188741128
Motor[1].Idata[13]=@
Motor[1].Idata[14]=8
Motor[1].Idatal15]1=0
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I 7.2. Loading and Downloading a Project

1 Start Power PMAC IDE, and
connect to the Controller.

2 In the Terminal tab page, type the
$$$*** command to reset the
Controller settings to factory

Terminal

default.
|$$$—x*1|
PowerPMAC Messages JEUUIGEIN Terminal Output
3 In the File menu, Click Open — @ roveouacoesris
} ) File | Edit View Debug Tools DeltaTau EtherCAT  Window Help
Project/Solution to load the e » o
project. ?FEV‘ * | 99 Project/Sclution... Ctrl+Shift+0
Close 20 File.. Ctrl+0

—— -
Upload Project From PowerPMAC
Save Selected rems Citrl+5

Save Selected ltems As...

W¥ Save Al Ctrl+Shift+S
Export 3
Import »
Page Setup...

Print... Ctrl+P
Recent Projects and Solutions »

B Bt Alt+F4

4 Right-click Configuration inthe | RN s--o oo e

L T
Solution Explorer pane, and T @lo-ap-=
I D I d C f FI t —{f Search Solution Explorer (Ctrl+;) P-
selec ownloa ontig rFiles to ] R88D-1SN
download the file to the Controller. b System

P [J Clanguage

| 4 B Codfiguation |

[ Add »

Scope to This
MNew Selution Explorer View

o I e W 1173

5 M Properties Alt+Enter

E Downlead Config Files

E Generate Config File
+ [ R8ED-1SN.cfg
[ systemsetup.cfg
I+ [ Documentation
P [d Leg
P 3 PMAC Script Language

Solution Explorer
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5 Right-click the project name in the | = cooe ~ 7 x

Solution Explorer, and select
Build and Download All
Programs to run the build and
download.

When the download process is
complete, make sure that there
are no errors in the Output
Window.

+ T,
T @ o-alr -
-
—A8 Search Solution Explorer (Ctrl+;) P~
l. T .
) .

b L3 Sys kil Build

b Emcl Rebuild

4 [ Z Col Clean

0O

Mew Solution Explorer View

EI Build and Download All Pregrams I

i} Map PMAC Vanables

%1 Add Macro Project

;1 Export Project with IP Protection...

] Export Project Template...

2 ¥ cut Chrl+X

K|
nload Project

0 Unload Proj
b [d Do & Open Folder in File Explorer
b 3 Log & Properties Alt+Enter
R

Selution Explorer

6 Stopping a program

If a program is running, execute
the following command from the
Terminal tab page to stop the
program.

disable plc 1

ECAT[0].Enable=0

R

|disable ple 1

PowerPMAC Messages MEINIGEN Terminal Output

|ECAT[D].EnabIe= 0

PowerPMAC Messages MIEIUILEIN Terminal Output
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7 Saving the downloaded settings

and programs

After the download process is
complete and you make sure that
there are no errors in the Output
Window, run the save command
from the Terminal tab page.

* The save command stores the
downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.

Terminal

Cat 192.16

|sava|
PowerPMAC Messages JIEUUIGEIN Terminal Output

Restarting after download

Run the following command from
the Terminal tab page to restart
the Controller with the
downloaded project.

$$$

Terminal

Sawving To Flash: Mounting the flash

Saving To Flash: Finizhed SAVING to flash

Save Completed

|sss|

PowerPMAC Messages IIEGUIGEN Terminal Output
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8. Appendix

Troubleshooting

I 8.1. Factors Causing EtherCAT Communications To Be Unavailable, and

Corrective Actions

Description

Factor

Corrective Action

The link is not established.

The Ethernet cable is broken or
the specified cable is not being
used.

If the Ethernet cable is broken
or if the specified cable was not
used, replace the cable.

A connector on the Ethernet
cable used for EtherCAT
communications is
disconnected, the contact is
faulty, or parts are faulty.

Reconnect the connector and
make sure it is mated correctly.

A slave within the EtherCAT
network configuration failed.

Replace the slave.

EtherCAT communications do
not start.

ECATI[0].Enable is set to 0.

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

The EtherCAT network
configuration in the Controller
does not agree with the
physical network configuration.

Review the settings according
to the procedures provided in
6.4 EtherCAT Communications
Setup.

The Ethernet cable is broken at
a slave in the network, or a
connector is disconnected.

Connect the Ethernet cable
correctly.

Some errors have occurred,
and the ECATJO].error is set to a
value other than 0.

Check the ECATIO].error value.

A synchronization error occurs
at a slave.

The distribution clock is not set
correctly.

A slave in Free-Run Mode is set
to the reference clock.

Review the settings according
to the procedures provided in
6.4.2 Distributed Clock Setup.

The servo task processing time
exceeds the set period.

Review the program or servo
frequency to adjust it, so that
the servo task processing time
does not exceed the period.
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I 8.2. How to Check for Errors

8.2.1. Checking the EtherCAT Status
You can check the EtherCAT status from Diagnosis Mode of Power PMAC IDE.

Right-click on Master0 (Deactivated) under EtherCAT in the Solution Explorer, then select
Diagnosis Mode to open the Diagnosis Mode page.

Selution Bxplorer
@ o-d
search Solution Explorer (Cirl
] RE8D-1SN
4 |5 System
b @ CPU

[3 Hardware
4 [ EtherCAT

k S

4 Diagnosis Mode

Scan EtherCAT Network

+ -

b 3 M
Ca Cd Append Slave
b [J En Jaste Slave
: - Ela: Import Slaves from EMI
3 Confis )
b [ Docwy  EXportENIFile
b [3 Log Load Mapping to PowerPMAC
4 [= PMAQ Load Mapping te PowerPMAC From ENI
4 [ Gl
g Activate EtherCAT
| Edit Topology

— K_I.r EoE Endpoint Configuration

Solution Expled = Oy

Scopeto This
MasterQ (Dea =1 pew Solution Explorer View

o B | F & Properties Alt+Enter
E Misc

EtherCAT License Maotors = 256

File Name MasterD (Deactivated)

Full Pat ChUsershdeltataud Decuments' PowerPN

Stack Type Acontis

You can check the status of the slaves in the Diagnosis Mode page.
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[N EE T R Master) (Deactivated) ® X

Device Editor
| General | Process Data Image " Watch list ” Performance " Variables ” CoE Object-Dictionary " History|
State Machine
Current State Pre-Op
Requested State Pre-Op
Init Bootstrap
Change State Pre-Op  Safe-Op
Op
Information Frame Counter
MNumber of found slaves 2 Sent frames 55067
Mumber of slaves in configuration 2 Lost frames 1]
Mumber of DC slaves 2 Cyclic frames 44678
DCin-sync WVes Acyclic frames 10289
Topology Ok Ves Clear counters
Link Connected Ves
Slaves in Master State Yes
Networks: 1 | Slaves:2 | State: @ @ | Mode: DIAGNOSIS
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8.2.2. Checking the Controller Status

In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system,
and system.

To display the Status page, click Status on the toolbar.

B Global Status
You can check system errors such as the WDT error.

Status

Motor Status] Coordinate Status ~ Global Status 1 MACRO Status }

Global Status

Description Status Description Status
AbortAll False HWChangeErr False
BufSizeErr False NoClocks False
ConfigLoadErr False ProjectlLoadErr False
Default True PwrOnFault False
FileConfigErr False WDTFault MNeoFault
FlashSizeErr False
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M Motor Status
You can check deviation errors, limit errors, and other states of the motor.

Status

Motor 1 |-

Description

AmpFault
AmpWarn
AuxFault
BIDir
BlockRequest
ClosedLoop
Csolve
DacLimit
DesVelZero
Encloss
FeFatal
FeWarn
GantryHomed
HomeComplete

HomelnProgress

® Motor activated

Motor Status I Coordinate Status] Global Status] MACRO Status 1

Status Description
LtFault

False InPos

False InterlockStop
False LimitStop

Plus MinusLimit
False PhaseFound
False PlusLimit

False SoftLimit

False SoftLimitDir
[T seftMinusLimit
False SoftPlusLimit
False SpindleMotor
False TraceCount
False TriggerMove
False TriggerNotFound
False TriggerSpeedSel

Status
False
False
False
False
False
False
False
False
Plus
False
False
False
0
False
False
MaxSpeed

A X

M Coordinate Status
You can check deviation errors, limit errors and other states of the coordinate system.

Status *AXx

Motor Status  Coordinate Status l Global Status] MACRO Status ]
Coordinate System 0 =
Description Status Description Status -

AmpEna False LookAheadActive False
AmpFault False LookAheadChange False
AmpWarn False LookAheadDir Forward
AuxFault False LookAheadFlush False
BlockActive False LookAheadlookBack False
BlockRequest False LookAheadReCalc False
BufferWarn 0 LookAheadStop False
CC3Active False LookAheadWrap False
CCAddedArc False MinusLimit False
CCMode Off MoveMode LineCircle
CCMoveType Dweell PlusLimit False
CCOffReq False ProgActive False
ClosedLoop False ProgProceeding False
ContMotion False ProgRunning False
Csolve False SegEnabled False
DesVelZero False SegHaltReq False
Encloss False SegMove Off
EndDelayActive False SegMovelccel False
ErrorStatus NoError SegMoveDecel False
FeedHold Off SegStopReq False
FeFatal False SharpCornerStop False
FeWarn False SoftMinusLimit False
HomeComplete False SoftPlusLimit False
HomelnProgress False TimerEnabled False
LRtFault False TimersEnabled False
InPos False TriggerMove False
InterlockStop False TriggerMotFound False -
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9. Appendix ECAT]Ii] Structure Elements

The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc.,
(hereafter referred to as DT) in the U.S., however, the ECAT]i] structure elements differ from those of
DT controllers. The following table shows the major changes that have been made from DT
controllers.

Element name Description Change
ECATIi].Enable Enabling the EtherCAT 0: Disable, 1: Enable
network (2 and 3 are not supported.)
ECATIi].LPIO[K] Elements of low priority Not supported
I/O module
ECAT]Ii].Slave[j] Slave elements Not supported
ECAT[i].Error Error code of enabling $ 9811000C: Invalid network
EtherCAT network configuration
$ 9811002E: Disconnected network
connection
ECATIi].LinkUp Status data structure Not supported

ECATI[i].LPDomainOutputState | elements
ECATI[i].LPDomainState
ECAT[i].LPRxTime

ECATI[i].LPTxTime

ECATI[i].MasterStat

ECAT[i]. RTDomainOutputState

ECATI[i]. RTDomainState
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